Getting Started Guide                                                                                    audible.com


	Welcome to Audible and

The Getting Started Guide!
We offer a wealth of spoken audio programming – over 34,000 hours and counting – which you can enjoy immediately.  This guide provides instruction for the three key steps to enjoying our digital audio:

1. Browse the store at audible.com and purchase programs you will love.

2. Manage your personal online library.

3. Download and listen at your desktop or transfer your audio to a portable player for enjoyment anywhere.

This guide can be used online as a quick reference or you may print a copy for reference when exploring the audible.com website.  

Happy Listening!

We welcome your comments and suggestions about this guide.

Please email them to gettingstartedguide@audible.com


[image: image1.jpg]audible.com®




Step One – Browse Selections and Shop at Audible

	Browse and Shop
	This section describes the variety of ways to browse, shop, and buy audio programs to entertain and inform you at audible.com.  You can:

· Browse highlighted selections.  We regularly update our website and feature new audiobooks and programs. 

· Listen to a sample of each and every program before you buy.

· Select items to purchase for your shopping basket.

· Use the search and advanced search features to find programs by a specific author, title or category.


	Sample audible.com Homepage
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	Browsing Audio Selections
	There are several ways to browse the audible.com “store”
(refer to sample audible.com homepage on the previous page).

1) Home page at audible.com is updated weekly with new releases, best sellers, and other audio programs of note.
2) Categories can be found at the top of the page beginning with Fiction.  New releases and best sellers in each category are featured on the category pages.
3) Subcategories are highlighted on the top navigation bar on each category page (e.g. Science Fiction).
4) Search and Advanced Search are located on the upper left hand side of the page. A simple search can be performed quickly by using our search field, located in the upper, left-hand corner of every page. Enter keywords related to the program you are searching for such as the title, author, or subject.  You may search for programs based on other criteria or multiple criteria by using Advanced Search.
5) Other featured titles are found under Good Listening on the left hand navigation bar.  These are webpages specially developed to focus on your interests.  For example: various best seller lists, award winners and staff recommendations. 
 

	Selecting an Item to Purchase


	You can select an item to purchase by clicking on Add to your Shopping Basket.
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Your audio selections will be added to your Shopping Basket and held there until you are ready to check out and complete your purchase. To view your Shopping Basket, select the icon at the top of the page.
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You can also create a Wish List of titles to consider for future purchases by clicking this icon. To view your Wish List, select the icon on the top of the page.





	Using Advanced Search


	Advanced Search is a tool that can be used to narrow the scope of results received when searching the thousands of titles in our store. 

Among its many useful capabilities, Advanced Search allows you to enter:

· keywords

· narrator

· subject

· running time

· format

· subscription edition titles

· publication date

· media type

· abridged/unabridged




	What else can you do on this page?


	On the Audible.com website you can access other pages at Audible.com such as: 
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Audible? – Provides information about our website and our company.
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Devices – Displays the AudibleReady devices available for mobile listening.
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Gift Center – Select the perfect gift for friends and family from Audible.
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Help – Takes you to our Help Center, where you can find FAQ’s, instructions, and documents like this.
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Listening – describes how to listen to your purchases either by streaming through your computer or downloading to an AudibleReady device.
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My Account – links to your personal account information, including payment information, email, streaming preferences, etc.  Note:  you will need your Audible password to access this area.
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My Library – stores all your purchases for future downloading and listening.




	You can also:
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View Your Wish List – During any of your visits to Audible you can place audio selections on a wish list to be easily accessed for a future purchase.
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View Your Basket – The shopping basket contains all items that you have added to your basket during your visit(s) to audible.com.  You come here when you are ready to check-out (buy) these items.  Items in your basket may also be removed from your basket, or moved to your wish list, at any time.




	If I am an AudibleListener, how do I use this page?


	If you are an AudibleListener you can find your book balance, subscription balance and renewal date in the top right corner.  This will tell you how many books or subscriptions you are entitled to at the time you log into Audible.

What is AudibleListener?

AudibleListenerTM plans are designed to save you a bundle every month on your favorite audio programs. Listen to our vast selection of audiobooks and subscriptions anytime, anywhere and save an average of more than 50% off our already low digital audio prices.
Each AudibleListener monthly membership plan provides you credits to purchase a specific number of programs each month for one low monthly fee. Go to www.audible.com/audiblelistener for a list of the current plans being offered. 


	Sample Web Page For an AudibleListener
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	What programs may I purchase using AudibleListener?   


	As you navigate through our website there will be AudibleListener icons next to programs that are available to you: 
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Blue AudibleListener icons identify audiobook programs available to Basic and PremiumListeners.
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Red AudibleListener icons identify 1-month subscriptions available to BasicListeners.




	Browse and Shop Summary


	Audible has thousands of titles to choose from!  In order to find the titles that interest you, we have created easy to use search methods.  Once you find a selection, try it out, put the audio selection into your shopping basket and proceed with your check out.

Audible.com is always open, 24 hours a day, seven days a week with prices 50% below the traditional audiobook cassettes or CDs.  Shop and Save!


Step Two – My Library, Your Personal Online Book Shelf

	What is My Library?
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	Think of My Library as your own personal bookshelf at Audible!  There is one “shelf” for Individual Programs (e.g., audiobooks) and one “shelf” for Subscriptions.

 In My Library you can:

· Find your purchases, either Individual Programs or Subscriptions

· Select a title for listening




	Sample “My Library” Web Page at audible.com
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	When Purchasing Individual Programs


	My Library contains all Individual Programs you have purchased from audible.com.
· Every time you complete your purchase of any title other than a subscription, the title(s) you have chosen are instantly placed in My Library under the New - Individual Programs tab.

· Once a title is in your library, you will be able to download and listen to it as often as you like – it is YOUR library and your selections will always be there.

· Use your library to download a copy or to listen to your audio program

	
	· Individual Programs are organized into three folders: 

New – Displays any purchases you have not yet downloaded. 

Heard – Lists audio programs you have already downloaded. 

Archive – Includes audio programs that you have previously moved    to the Archive.


	Sample “My Library” Web Page for New Subscriptions
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	When Purchasing Subscriptions

	My Library contains all your subscription content, such as The New York Times, Scientific American or All Things Considered.

The section tabs are set up in two folders:

New –

We immediately deliver the latest copy of your subscription and display the selection in the New folder. Based on the timing of the subscription (e.g. daily, weekly, monthly) the next issue will be placed in this folder on the date it is issued.

Archive –
Provides access to older issues of your subscriptions.
Note:  You can request to be notified by email when a new edition is delivered to “My Library” by going to “My Preferences”.


	Selecting a Program to Download or Listen to
	The Get It Now button [image: image20.png]Get it now




 will bring you to the page where you can choose how you would like to listen to your audio program.




	My Library Summary
	My Library is your online bookshelf!  You can access your titles as often as you like.  There is no waiting for the mail; your selections are instantly placed on your library shelf.  To listen, all you need to do is “Get it now”.


Step Three – Listening to Your Audible Audio

	How Do You Listen?
	Listening to your selections takes three simple steps:

1. Determine how you would like to listen, either connected to the Internet or locally on your computer.

2. Get your audio. 

3. Listen!


	Sample “My Library – Get it now” Web Page
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	What will you do on the “Get it now” Page?
	On this page of the audible.com website, you can choose how you would like to listen to your audio program.

There are two action steps:

1. Choose a format
2. Choose a delivery method


	Choosing a Format

 
	Audible programs are available in a variety of “formats.”  Most mobile players are designed by their manufacturers to play one or two Audible formats.  

· If your player supports more than one format, this choice allows you to control the download and playback experience.  Smaller files are represented by lower format numbers (e.g. formats 1 and 2).  They download faster – especially over a dial-up connection – and allow you to fit more audio on your mobile player.

· Larger files are represented by higher format numbers (e.g. formats 3 and 4).  These offer higher fidelity sound.

You choose between fast downloads, how many hours of audio can be loaded and high fidelity. The manufacturer of each portable device determines which formats the player will be able to use.

Once you set up your mobile player(s) with your Audible account, the website will display for you which formats your player(s) support.


	Choosing a File Delivery Method


	There are two choices when it comes to file delivery, you can:

· Download – The audio file will be downloaded from the audible.com website to your PC or Mac. You only need to be connected to the Internet while downloading.

· Stream – The audio will be played for you while connected to the audible.com website; you must be connected to the Internet.

Note: Mac customers may only Download their audio files, as streaming of Audible audio is not currently supported


	What is Downloading?


	Downloading delivers your audio over the Internet and stores it on your computer.  You can then listen on your computer or transfer to an AudibleReady device.

You need enough disk space on your computer to hold the audio files that are downloaded.  If space is an issue, you can delete each audio file from your computer after listening.  The file will remain in My Library until the next time you would like to access the title.  To find out how big the file will be, look at the size listed below each format.


	How to download using a PC


	Downloading is an interim step to listening.  Using a PC, the file downloads to your computer via AudibleManager  (PC software distributed by Audible) in order to be transferred to an AudibleReady mobile device or burned to CD.

If you have not already installed AudibleManager on your PC, this software will be automatically installed the first time you request to download an audio program (i.e. click on the Download button) or by going to www.audible.com/software 

To begin the download of your Audible audio program using the “Get it Now” webpage:

1. Select the Format you wish to use

2. Click on the “Download” button

3. If your PC is not yet running the AudibleManager software, then the audible website will request that your PC begin running the program … this may take a few moments to happen

4. The audible.com website will then begin a download of your requested audio program into AudibleManager on your PC.  At the end of the download, the audio program will appear in the Inbox window of AudibleManager.

Most Audible customers download their audio because it is much more convenient to start listening and then be able to stop and place a bookmark or transfer to a mobile player.  


	How to download using a Mac


	Before you listen to Audible programs on your Mac you will need to install Apple’s iTunes3 software. If you have not done this yet, please go to www.apple.com/itunes and follow the directions to download and install the software on your Mac computer.

Note:  iTunes3 is only available for the Mac OS X operating system

To prepare iTunes to receive downloads from the audible.com website, please perform the following steps (this needs to be done only one time):

1. Quit your Internet browser software and any email applications that may be open


2. Within the iTunes3 application, select the Preferences menu


3. Click on the General icon

4. Click on the Set button next to the label “Use iTunes for Internet Music Playback”


5. Click OK button on the next two Dialog boxes that appear


Your Mac is now all set to surf and download content from Audible.com – and play the content using iTunes or your iPod.

To download your audio program 

· Selected your desired Format for the audio on the “Get it Now” webpage, and click on the “Download” button.  The Audible website will begin to download your audio program into your iTunes library.

· To listen, simply find the Audible audio file within iTunes and double-click on it. iTunes will begin to play the file.

· If this is your first time using iTunes to play an Audible program, you will be asked to activate your Mac. Enter the username and password you use at audible.com to complete the activation process.




	How do I use my Mac to Listen to Audio, Burn to CDs and Transfer  to my iPod?


	· To listen to your Audible audio program, simply find the Audible audio file within iTunes and double-click on it. iTunes will begin to play the file.

· If this is your first time using iTunes to play an Audible program, you will be asked to activate your Mac. Enter the username and password you use at audible.com to complete the activation process.

· iTunes software may be used to burn most Audible audio programs onto audio CDs for playback in any CD player, such as a car stereo, home stereo, or portable CD player.  To burn a CD:

· Create a playlist within iTunes containing the desired Audible program, and

· Click the “Burn CD” Icon or choose menu option 
File -> Burn Playlist to CD.

· Start/Stop Time – For audio programs that are longer than 60-70 minutes, you MUST choose the portion of your audio program to burn to CD by entering the Start Time and Stop Time.

Choose menu option File -> Get Info, then select the “Options” tab.

Here you will find the Start Time and Stop Time fields.

For example, a 6 hour audiobook will take up to 6 CDs to burn the entire program – the first CD holding minutes 0 to 60, the second CD starting at 60 and stopping at 120 minutes, and so on.  The typical CD-R disk has the capacity to hold between 60 and 80 minutes of audio (check the packaging of your CD-R for capacity information provided by the manufacturer). 

You will need to set the Start Time and Stop Time for each CD you burn of this program to create a complete set of 6 CDs spanning the entire program.


· iTunes may also be used to transfer your Audible audio program to your iPod MP3 player.   Audible formats 2, 3, and 4 may all be played on your iPod.

· Please refer to the Help function within iTunes or go online to www.apple.com/support/itunes for more detailed information about using iTunes with Audible audio programs



	What is Streaming?

Note:  This section does not apply to Mac Users
 
	Streaming plays your audio immediately as it is delivered over the Internet.   

The perfect use for streaming is when you are at a computer which has sound and you would like to listen to your audio program immediately.  Streaming uses media player software on your computer.  If you do not already have the software, Real Player or Windows Media Player may be installed on your computer at no additional charge.  (Almost all PCs come with one or both programs already pre-installed).

Note:

· You must remain connected to the Internet – you cannot stream audio with a mobile player

· The file is not retained on your computer for future listening

· You cannot bookmark starting and stopping points for future listening



	What can you do using AudibleManager on your PC?  

Note:  This section does not apply to Mac Users


	AudibleManager is where you can manage your audio programs locally on your PC.  While working within AudibleManager, you do not need to be connected to the Internet.  You can:

· Review the list of titles downloaded and stored on your computer.

· Transfer programs to your AudibleReady mobile device.
The downloaded programs will be listed on the top half of your page.  You can highlight your choice and click the Add to Device button.

· Burn your audio to a CD for playback on an audio CD player.
· Listen at your computer.

· Show details about the title or subscription.
Display more information about your selection by highlighting your choice and clicking on the Show Details button.

· Delete files from your computer.


Note:  Titles you delete from your computer will be retained in the My Library section of audible.com for future download.


	Sample AudibleManager Window
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	Activating your computer or AudibleReady mobile device 


	Activation is the process of identifying that your computer or mobile device is allowed to play Audible programs that belong to you. 

When you install AudibleManager you will be asked to activate your desktop player (Windows Media Player or Real Player) and your AudibleReady mobile device.

During the activation process you will be asked to check the items you want to activate. They are usually pre-checked for you based on your installation. The next step will ask you for your audible.com username and password. In the final step, AudibleManager will attempt to connect to the Internet and activate your desktop player and/or AudibleReady mobile device with the audible.com website.

If you need further help or run into any errors during this process, you can find help in AudibleManager or at our website. Simply click on the “More Help” button, or go to “Help” in the Windows toolbar.


	Transferring Programs to a Device 
	Transfer Audible programs to an AudibleReady mobile device and take it with you to listen in the car, on the treadmill, anywhere you go.  From within AudibleManager, programs you have downloaded to your computer are listed in the upper half of the AudibleManager window.  Programs on your mobile device, and free space available for additional audio, are shown in the lower half.


Follow these steps to transfer audio:

1. Ensure your device is activated – this process registers the device with audible.com as yours, and authorizes it to play the Audible programs you have purchased.

If you have not already done so, you may activate your device by choosing Devices -> Activate/Deactivate from the menu bar.   You only need to perform this one time for each device you own.


2. Ensure your mobile device is turned on and connected to your computer via the USB cable or other cable appropriate for your device.  When connected, the lower window of the AudibleManager program will display the current audio contents of your device.

If you do not see a picture of your device or your device’s contents in the lower window, choose Devices -> Choose Mobile Device from the menu bar.  Then select your mobile device from the list of devices displayed.


3. Transfer your audio program to the mobile device by dragging the program from the upper window (Inbox) to the lower window (Device) and dropping it on the list.


4. The Transfer Dialog will ask if you want to fill all available memory on the mobile device or select a segment length to transfer. If you transfer only a segment and not the entire program, you can enter the length of time you want to transfer.


5. Click OK to continue.


6. After the transfer is complete, disconnect the mobile device and start listening.


	Transferring Additional portions of a program to my device 
	Each AudibleReady device provides a specific amount of storage for audio programs.  If your selection exceeds the storage space available on your device, you can listen to the audio title in parts.

· Many programs will exceed the amount of memory storage available on your AudibleReady device. So AudibleManager will transfer the maximum amount of audio it can.

· When you are finished listening to some or all of the audio you transferred, simply re-connect the device to your computer

· Find the name of the audio program that you transferred on the upper pane of AudibleManager, and drag it again to the lower pane (where that same program should already be listed in your device).

· AudibleManager will recognize how much of the audio program you have already listened to, and transfer the next appropriate section of the audio to your device.

· You can use this method repeatedly until you have listened to the entire audio program.


	Getting Help in AudibleManager


	You can learn more about the functionality of AudibleManager by accessing the Help menu at the top of the AudibleManager screen.

There you can learn about the Advanced mode for AudibleManager where you can:

· Schedule the automatic download of your subscription programs,

· Sync your portable device, and

· Set up transfer lists for your mobile device.


	Listen at your Computer


	If you would like to listen at your computer, select the program you wish to hear in the upper window and then click on the Play button.

Listening at your computer requires using Windows Media Player, Real Player, or the Audible Desktop Player.  You may select which audio player you prefer to use within AudibleManager by choosing the menu Options -> Select Desktop Player.

If you do not already have one of these audio players installed on your PC, the first time you click the Play button you will be prompted to download and install this software for no additional charge.  Most computers come with Windows Media Player already installed.

Once installed, you can start, pause, stop, rewind and fast forward using the buttons on the player.


	Burning to CD


	Most Audible programs may be burned to CD(s) so that they may be played in any audio CD player.  To do this, your PC must be equipped with a CD-R/W drive (commonly called a “CD Burner”).

To begin the CD Burning process, click on the button labeled CD Burn Mode – the lower window of AudibleManager will become the list of program(s) you wish to burn on CD.

If AudibleManager detects that additional software is needed for CD burning, the software will prompt you to be connected to the Internet and access that software.  This will only happen the first time you request to burn a CD.

Go to www.audible.com/helpme and click on the Getting Started Guides link to retrieve a Guide to CD Burning.  The Guide provides complete instructions for burning Audible audio CDs using your PC.


	How to Listen Summary


	Listen on the go – in a car, on your commute, while exercising, or in place at your computer, anyplace, anytime.

All you need to do is shop and purchase, find the audio in My Library, and then determine when and how you would like to listen.
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